# Using Mail Merge in Word 2010

## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Mail Merge to Create and Print Letters and Other Documents</td>
<td>3</td>
</tr>
<tr>
<td><strong>Set Up the Main Document</strong></td>
<td>3</td>
</tr>
<tr>
<td>Connect the Document to a Data Source</td>
<td>4</td>
</tr>
<tr>
<td>Choose a data file</td>
<td>4</td>
</tr>
<tr>
<td>Working with the Microsoft Outlook Contacts list</td>
<td>5</td>
</tr>
<tr>
<td>Tips for formatting data in Excel</td>
<td>5</td>
</tr>
<tr>
<td>Use a table or query as a mail-merge data source</td>
<td>5</td>
</tr>
<tr>
<td>Refine the List of Recipients or Items</td>
<td>6</td>
</tr>
<tr>
<td>Add Placeholders (Mail Merge Fields)</td>
<td>7</td>
</tr>
<tr>
<td>What happens when you merge</td>
<td>8</td>
</tr>
<tr>
<td>Working with fields</td>
<td>8</td>
</tr>
<tr>
<td>Map mail merge fields to your data file</td>
<td>9</td>
</tr>
<tr>
<td>Type Content and Add Fields</td>
<td>9</td>
</tr>
<tr>
<td>Preview the Merge</td>
<td>10</td>
</tr>
<tr>
<td>Complete the Merge</td>
<td>10</td>
</tr>
<tr>
<td>Print the merged documents</td>
<td>10</td>
</tr>
<tr>
<td>Change individual copies of the document</td>
<td>11</td>
</tr>
<tr>
<td>Save the Main Document</td>
<td>11</td>
</tr>
<tr>
<td>Resume a Mail Merge</td>
<td>11</td>
</tr>
<tr>
<td>Run Mail Merge from Outlook</td>
<td>12</td>
</tr>
<tr>
<td>Create and Print Envelopes for a Mass Mailing</td>
<td>12</td>
</tr>
<tr>
<td><strong>Set Up the Envelope</strong></td>
<td>13</td>
</tr>
<tr>
<td>Set up a return address</td>
<td>13</td>
</tr>
<tr>
<td>Verify the printing options</td>
<td>13</td>
</tr>
<tr>
<td>Work on the Envelope Main Document</td>
<td>14</td>
</tr>
<tr>
<td>Connect the Envelopes to Your Address List</td>
<td>15</td>
</tr>
<tr>
<td>Choose a data file</td>
<td>15</td>
</tr>
<tr>
<td>Refine the list of recipients</td>
<td>15</td>
</tr>
<tr>
<td>Add Placeholders (Mail Merge Fields)</td>
<td>15</td>
</tr>
<tr>
<td>Add the content</td>
<td>15</td>
</tr>
<tr>
<td>Add the fields</td>
<td>16</td>
</tr>
<tr>
<td>Preview the Merge</td>
<td>16</td>
</tr>
<tr>
<td>Print the Envelopes</td>
<td>16</td>
</tr>
<tr>
<td>Change individual envelopes</td>
<td>16</td>
</tr>
<tr>
<td>Save the Envelope Main Document</td>
<td>16</td>
</tr>
<tr>
<td>Create and Print Labels for a Mass Mailing</td>
<td>17</td>
</tr>
<tr>
<td><strong>Set Up the Labels</strong></td>
<td>17</td>
</tr>
<tr>
<td>Connect the Labels to Your Address List</td>
<td>18</td>
</tr>
<tr>
<td>Choose a data file</td>
<td>18</td>
</tr>
<tr>
<td>Refine the list of recipients</td>
<td>18</td>
</tr>
</tbody>
</table>
ADD PLACEHOLDERS (MAIL MERGE FIELDS) .......................................................... 18
  Map the mail merge fields to your data file ........................................................ 18
TYPE THE CONTENT AND ADD THE FIELDS ...................................................... 19
ADD A GRAPHIC TO LABELS ............................................................................ 19
PREVIEW THE MERGE .......................................................................................... 20
COMPLETE THE MERGE.................................................................................... 20
  Print the labels ................................................................................................. 20
  Change individual labels ............................................................................... 20
SAVE THE LABEL MAIN DOCUMENT .................................................................. 20

CREATE AND PRINT A SHEET OF THE SAME LABELS ........................................ 20

USE MAIL MERGE TO SEND PERSONALIZED E-MAIL MESSAGES TO YOUR E-MAIL
ADDRESS LIST .................................................................................................... 21
SET UP THE E-MAIL MESSAGE MAIN DOCUMENT ........................................... 21
CONNECT THE E-MAIL MESSAGE DOCUMENT TO YOUR ADDRESS LIST .......... 21
  Choose a data file ............................................................................................ 21
  Refine the list of recipients or items ................................................................. 21
ADD PLACEHOLDERS (MAIL MERGE FIELDS) .................................................... 22
  Type content and add fields ........................................................................... 22
PREVIEW AND COMPLETE THE MERGE ........................................................... 22
SAVE THE E-MAIL MESSAGE MAIN DOCUMENT ............................................. 22
SEND THE E-MAIL MESSAGES ......................................................................... 23
Use mail merge to create and print letters and other documents

You use mail merge when you want to create a set of documents, such as a form letter that is sent to many customers or a sheet of address labels. Each letter or label has the same kind of information, yet the content is unique. For example, in letters to your customers, each letter can be personalized to address each customer by name. The unique information in each letter or label comes from entries in a data source.

The mail merge process entails the following overall steps:

1) **Set up the main document.** The main document contains the text and graphics that are the same for each version of the merged document. For example, the return address or salutation in a form letter.

2) **Connect the document to a data source.** A data source is a file that contains the information to be merged into a document. For example, the names and addresses of the recipients of a letter.

3) **Refine the list of recipients or items.** Microsoft Office Word generates a copy of the main document for each item, or record, in your data file. If your data file is a mailing list, these items are probably recipients of your mailing. If you want to generate copies for only certain items in your data file, you can choose which items (records) to include.

4) **Add placeholders, called mail merge fields, to the document.** When you perform the mail merge, the mail merge fields are filled with information from your data file.

5) **Preview and complete the merge.** You can preview each copy of the document before you print the whole set.

You use commands on the **Mailings** tab to perform a mail merge.

**Tip:** You can also perform a mail merge by using the **Mail Merge** task pane, which leads you step by step through the process.

To use the task pane, in the **Start Mail Merge** group on the **Mailings** tab, click **Start Mail Merge**, and then click **Step by Step Mail Merge Wizard**.

### Set up the main document

1) Start Word.

2) A blank document opens by default. Leave it open. If you close it, the commands in the next step are not available.

3) On the **Mailings** tab, in the **Start Mail Merge** group, click **Start Mail Merge**.

4) Click the type of document that you want to create.
For example, you can create:

- **A set of envelopes**: The return address is the same on all the envelopes, but the destination address is unique on each one. Click **Envelopes**, and then specify your preferences for envelope size and text formatting on the **Envelope Options** tab of the **Envelope Options** dialog box.

- **A set of address labels**: Each label shows a person's name and address, but the name and address on each label is unique. Click **Labels**, and then specify your preferences for the type of label in the **Label Options** dialog box.

- **A set of form letters or e-mail messages**: The basic content is the same in all the letters or messages, but each contains information that is specific to the individual recipient, such as name, address, or some other piece of information. Click **Letters** or **E-mail messages** to create these types of documents.

- **A catalog or directory**: The same kind of information, such as name and description, is shown for each item, but the name and description in each item is unique. Click **Directory** to create this type of document.

**Connect the document to a data source**

To merge information into your main document, you must connect the document to a data source, or a data file. If you don't already have a data file, you can create one during the mail merge process.

**Choose a data file**

1) On the **Mailings** tab, in the **Start Mail Merge** group, click **Select Recipients**.

2) Do one of the following:

   a) If you want to use your Contacts list in Outlook, click **Select from Outlook Contacts**.

   b) If you have a Microsoft Office Excel worksheet, a Microsoft Office Access database, or another type of data file, click **Use Existing List**, and then locate the file in the **Select Data Source** dialog box.

      - For Excel, you can select data from any worksheet or named range within a workbook. For Access, you can select data from any table or query that is defined in the database.

      - For another type of data file, select the file in the **Select Data Source** dialog box. If the file is not listed, select the appropriate file type or select **All Files** in the **Files of type** box. In a mail merge, you can use the following types of data files:

         1. Files from single-tier, file-based database programs for which you have installed an OLE DB provider or ODBC driver (a number of which are included with Microsoft Office).

         2. An HTML file that has a single table. The first row of the table must contain column names, and the other rows must contain data.

         3. Electronic address books

            a) Microsoft Outlook Address Book

            b) Microsoft Schedule+ 7.0 Contact List

            c) Any similar address lists that were created with a MAPI compatible messaging system, such as Microsoft Outlook.

         4. A Microsoft Word document. The document should contain a single table. The first row of the table must contain headings, and the other rows must contain the records that you want to merge.

         5. Any text file that has data fields separated (or delimited) by tab characters or commas and data records separated by paragraph marks.

   c) If you don’t have a data file yet, click **Type a new list**, and then use the form that opens to create your list. The list is saved as a database (.mdb) file that you can reuse.
**Working with the Microsoft Outlook Contacts list**

Connecting to your Outlook Contacts folder is usually a straightforward process, but sometimes you may encounter a problem. Here are solutions to common problems that you may encounter:

I can't find my Outlook Contacts folder

You may need to turn on the *Show this folder as an e-mail Address Book* property in Outlook, or you may need to change your Outlook user profile.

**Turn on the “Show this folder as an e-mail Address Book” property**

1) In Microsoft Office Outlook, click **Contacts**.

2) Right-click the **Contacts** folder that contains the information that you want to use for a mail merge, and then click **Properties**.

3) On the **Outlook Address Book** tab, make sure that the *Show this folder as an e-mail Address Book* check box is selected, and then click **OK**.

---

**Tips for formatting data in Excel**

If your data file is an Excel worksheet that includes percentages, currency values, or postal codes, you can preserve the numeric formatting of the data by using Dynamic Data Exchange to connect to the Excel worksheet from Word. For example, you can make sure a five-digit postal code of 07865 from your data file is not displayed as the number 7865 (without the leading zero).

Before you connect to the worksheet, do the following in Word:

1) Click the **File** tab, and then click **Options**.

2) Click **Advanced**.

3) Scroll to the **General** section, and select the **Confirm file format conversion on open** check box.

4) Click **OK**.

5) With the mail merge main document open, in the **Start Mail Merge** group of the **Mailings** tab, click **Select Recipients**, and then click **Use Existing List**.

6) Locate the Excel worksheet in the **Select Data Source** dialog box, and double-click it.

7) In the **Confirm Data Source** dialog box, click **MS Excel Worksheets via DDE (*.xls)**, and then click **OK**.

   a) If you don't see **MS Excel Worksheets via DDE (*.xls)**, select the **Show all** check box.

8) In the **Microsoft Office Excel** dialog box, for **Named or cell range**, select the cell range or worksheet that contains the information that you want to merge, and then click **OK**.

**Note:** To prevent being prompted every time you open a data file, you can turn off the **Confirm conversion on open** option after you have connected to the worksheet.

**Use a table or query as a mail-merge data source**

You can create a mail merge operation by using the Microsoft Word Mail Merge Wizard. This wizard is also available from Microsoft Office Access 2010, and lets you set up a mail merge process that uses a table or
query in an Access database as the data source for form letters, e-mail messages, mailing labels, envelopes, or directories.

This topic explains how to start the Mail Merge Wizard from Access and create a direct link between a table or query and a Microsoft Office Word 2010 document. These steps cover the process for writing letters:

1) Open the source database, and in the Navigation Pane, select the table or query that you want use as the mail merge data source.

2) On the External Data tab, in the Export group, click Word Merge.

3) The Microsoft Word Mail Merge Wizard starts.
   a) Select whether you want to create the link in an existing document or in a new document, and then click OK.
      • If you chose to link to an existing document, in the Select Microsoft Word Document dialog box, locate and select the file, and then click Open.
   b) Word starts. Depending on your choice, Word opens either the document you specified or a new document.

4) In the Mail Merge pane, under Select document type, click Letters and then click Next: Starting document to continue to step 2.

5) In step 2, click Next: Select recipients.

6) In step 3, you create the link between the data source in Access and the Word document. Because you started the wizard from Access, this link is created automatically. Under Select recipients, note that Use an existing list is selected, and the name of your data source is displayed under Use an existing list.

7) Click Edit recipient list if you want to customize the contents of the table or query.
   a) You can filter, sort, and validate the data. Click OK to continue.

8) Click Next: Write your letter to continue. Follow the remaining instructions in the Mail Merge pane, and in step 5 of the task pane, click Next: Complete the merge.

Refine the list of recipients or items

When you connect to a certain data file, you might not want to merge information from all the records in that data file into your main document.

To narrow the list of recipients or use a subset of the items in your data file, do the following:

1) On the Mailings tab, in the Start Mail Merge group, click Edit Recipient List.

2) In the Mail Merge Recipients dialog box, do any of the following:
   a) Select individual records:
      • This method is most useful if your list is short. Select the check boxes next to the recipients you want to include, and clear the check boxes next to the recipients you want to exclude.
      • If you know that you want to include only a few records in your merge, you can clear the check box in the header row and then select only those records that you want. Similarly, if you want to include most of the list, select the check box in the header row, and then clear the check boxes for the records that you don't want to include.
b) **Sort records:**

- Click the column heading of the item that you want to sort by. The list sorts in ascending alphabetical order (from A to Z). Click the column heading again to sort the list in descending alphabetical order (Z to A).
- If you want more complex sorting, click **Sort** under **Refine recipient list** and choose your sorting preferences on the **Sort Records** tab of the **Filter and Sort** dialog box. For example, you can use this type of sorting if you want recipient addresses to be alphabetized by last name within each zip code and the zip codes listed in numerical order.

c) **Filter records:**

- This is useful if the list contains records that you know you don't want to see or include in the merge. After you filter the list, you can use the check boxes to include and exclude records.
- To filter records, do the following:
  1. Under **Refine recipient list**, click **Filter**.
  2. On the **Filter Records** tab of the **Filter and Sort** dialog box, choose the criteria you want to use for the filter.
      a) For example, to generate copies of your main document only for addresses that list Australia as the country/region, you would click **Country or Region** in the **Field** list, **Equal to** in the **Comparison** list, and **Australia** in the **Compare to** list.
  3. To refine the filter further, click **And** or **Or**, and then specify more criteria.
      a) For example, to generate copies of your main document only for businesses in Munich, you would filter on records whose **City** field contains **Munich** and whose **Company Name** field is not blank. If you use **Or** instead of **And** in this filter, your mail merge includes all Munich addresses as well as all addresses that include a company name, regardless of city.

**Note:** If you have installed address validation software, you can click **Validate addresses** in the **Mail Merge Recipients** dialog box to validate your recipients’ addresses.

**Add placeholders (mail merge fields)**

After you connect your main document to a data file, you are ready to type the text of the document and add placeholders that indicate where the unique information will appear in each copy of the document. The placeholders, such as address and greeting, are called **mail merge fields**. Fields in Word correspond to the column headings in the data file that you select.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Name</td>
<td>Last Name</td>
<td>Street Address</td>
</tr>
<tr>
<td>2</td>
<td>Nancy</td>
<td>Anderson</td>
<td>123 Main St.</td>
</tr>
<tr>
<td>3</td>
<td>Ann</td>
<td>Beebe</td>
<td>567 Country Rd.</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1. Columns in a data file represent categories of information. Fields that you add to the main document are placeholders for these categories.
2. Rows in a data file represent records of information. Word generates a copy of the main document for each record when you perform a mail merge.
By putting a field in your main document, you indicate that you want a certain category of information, such as name or address, to appear in that location.

Note: When you insert a mail merge field into the main document, the field name is always surrounded by chevrons (« »). These chevrons do not show up in the merged documents. They just help you distinguish the fields in the main document from the regular text.

What happens when you merge

When you merge, information from the first row in the data file replaces the fields in your main document to create the first merged document. Information from the second row in the data file replaces the fields to create the second merged document, and so on.

Working with fields

You can add any column heading from your data file to the main document as a field. This gives you flexibility when you design form letters, labels, e-mail messages, and other merged documents.

You can combine fields and separate them by punctuation marks. For example, to create an address, you can set up the fields in your main document like this:

«First Name» «Last Name»
«Street Address»
«City», «State» «Postal code»

For things that you use frequently, like address blocks and greeting lines, Word provides composite fields that group a number of fields together. For example:

- The **Address Block** field is a combination of several fields, including first name, last name, street address, city, and postal code.
- The **Greeting Line** field can include one or more name fields, depending on your chosen salutation.
  - You can customize the content in each of these composite fields. For example, in the address, you may want to select a formal name format (Mr. Joshua Randall Jr.); in the greeting, you may want to use "To" instead of "Dear."
Map mail merge fields to your data file
To make sure that Word can find a column in your data file that corresponds to every address or greeting element, you may need to map the mail merge fields in Word to the columns in your data file.

1) Click **Match Fields** in the **Write & Insert Fields** group of the **Mailings** tab.
   
   a) The **Match Fields** dialog box opens.
   
   b) The elements of an address and greeting are listed on the left. Column headings from your data file are listed on the right.
   
   c) Word searches for the column that matches each element. In the illustration, Word automatically matched the data file's **Surname** column to **Last Name**. But Word was unable to match other elements. From this data file, for example, Word can't match **First Name**.

2) In the list on the right, you can select the column from your data file that matches the element on the left. In the illustration, the **Name** column now matches **First Name**. It's okay that **Courtesy Title**, **Unique Identifier**, and **Middle Name** aren't matched. Your mail merge document doesn't need to use every field. If you add a field that does not contain data from your data file, it will appear in the merged document as an empty placeholder — usually a blank line or a hidden field.

Type content and add fields

1) In the main document, click where you want to insert the field.

2) In the **Write & Insert Fields** group on the **Mailings** tab, add any of the following:

   a) Address block with name, address, and other information:
      
      - Click **Address block**.
      - In the **Insert Address Block** dialog box, select the address elements that you want to include and the formats that you want, and then click **OK**.
      - If the **Match Fields** dialog box appears, Word may have been unable to find some of the information that it needs for the address block. Click the arrow next to **(not matched)**, and then select the field from your data source that corresponds to the field that is required for the mail merge.

   b) Greeting line:
      
      - Click **Greeting line**.
      - Select the greeting line format, which includes the salutation, name format, and following punctuation.
      - Select the text that you want to appear in cases where Microsoft Word can't interpret the recipient's name, for example, when the data source contains no first or last name for a recipient, but only a company name.
      - Click **OK**.
c) Individual fields:

- You can insert information from individual fields, such as first name, telephone number, or the amount of a contribution from a list of donors. To quickly add a field from your data file to the main document, click the arrow next to **Insert Merge Field**, and then click the field name.
- For more options with inserting individual fields in the document, do the following:
  1. On the **Mailings** tab, in the **Write & Insert Fields** group, click **Insert Merge Field**.
  2. In the **Insert Merge Field** dialog box, do one of the following:
     a. To select address fields that will automatically correspond to fields in your data source, even if the data source's fields don't have the same name as your fields, click **Address Fields**.
     b. To select fields that always take data directly from a column in your data file, click **Database Fields**.
     Note: If you insert a field from the Database Fields list and then later switch to a data source that doesn't have a column with the same name, Word won't be able to insert that field information into the merged document.
  3. In the **Fields** box, click the field you want.
  4. Click **Insert**, and then click **Close**.

Notes:

- You can't type merge field characters («« »») manually or use the **Symbol** command on the **Insert** menu. You must use mail merge.
- If the merge fields appear inside braces, such as { MERGEFIELD City }, then Microsoft Word is displaying field codes instead of field results. This doesn't affect the merge, but if you want to display the results instead, right-click the field code, and then click **Toggle Field Codes** on the shortcut menu.

### Preview the merge

You can preview your merged documents and make changes before you actually complete the merge.

Do any of the following in the **Preview Results** group of the mailings tab.

1) Click **Preview Results**.

2) Page through each merged document by using the **Next Record** and **Previous Record** buttons in the **Preview Results** group.

3) Preview a specific document by clicking **Find Recipient**.

Note: Click **Edit Recipient List** in the **Start Mail Merge** group on the **Mailings** tab to open the **Mail Merge Recipients** dialog box, where you can filter the list or clear recipients if you see records that you don't want to include.

### Complete the merge

You can print the merged documents or modify them individually. You can print or change all or just a subset of the documents.

### Print the merged documents

1) On the **Mailings** tab, in the **Finish** group, click **Finish & Merge**, and then click **Print Documents**.
2) Choose whether to print the whole set of documents, only the copy that's currently visible, or a subset of the set, which you specify by record number.
Change individual copies of the document

1) On the Mailings tab, in the Finish group, click Finish & Merge, and then click Edit Individual Documents.

2) Choose whether you want to edit the whole set of documents, only the copy that's currently visible, or a subset of the set, which you specify by record number. Word saves the copies that you want to edit to a single file, with a next page section break between each copy of the document.

**Note:** If you do not want to print all of the individual documents, you must indicate which pages and sections to print in the Print dialog box. For example, to print the first page of the second record you must open the Print dialog box and type “p1s2” in the Pages area of the Page Range section. If that record’s document spread out over two pages, you would type: “p1s2-p2s2” – this tells Word to print page 1 of section 2 and page 2 of section 2.

Save the main document

Remember, merged documents that you save are separate from the main document. It's a good idea to save the main document itself if you plan to use it for another mail merge.

When you save the main document, you also save its connection to the data file. The next time that you open the main document, you are prompted to choose whether you want the information from the data file to be merged again into the main document.

- If you click Yes, the document opens with information from the first record merged in.
- If you click No, the connection between the main document and the data file is broken. The main document becomes a standard Word document. Fields are replaced with the unique information from the first record.

Resume a mail merge

If you need to stop working on a mail merge, you can save the main document and resume the merge later. Word retains the data source and field information. If you were using the Mail Merge task pane, Word returns to your place in the task pane when you resume the merge.

1) When you are ready to resume the merge, open the document.
   a) Word displays a message that asks you to confirm whether you want to open the document, which will run an SQL command.
2) Because this document is connected to a data source and you want to retrieve the data, click Yes. If you were opening a document that you did not realize was connected to a data source, you could click No to prevent potentially malicious access to data.
3) The text of the document appears, along with any fields that you inserted.
4) Click the Mailings tab, and resume your work.
Run mail merge from Outlook

1) In Outlook Contacts, select individual contacts by pressing **SHIFT** and clicking to select a range or by pressing **CTRL** and clicking to select individuals. If you want to include all the contacts currently visible in the view, do not click on any contacts.

2) On the **Home** tab / **Actions** group / click **Mail Merge**.
   a) If you have selected individual contacts to include in the merge, click **Only selected contacts**. If you want to include all the contacts currently visible in the view, click **All contacts in current view**.
   b) If you have configured the Phone List view so that it displays exactly the fields you want to use in the merge, click **Contact fields in current view**. Otherwise, click **All contact fields** to make all of the contact fields available in the merge.

3) If you want to generate a new main document for the merge, click **New document**. Otherwise, click **Existing document**, and click **Browse** to locate the document to use as the main document.

4) If you want to save the contacts and fields that you have selected, so that they can be reused, select the **Permanent file** check box, and then click **Browse** to save the file. The data is saved in a Word document as comma-delimited data.

5) Select any merge options you want:
   a) Document types:
      - **Form Letters**: Prepare a batch of letters for a mass mailing.
      - **Mailing Labels**: Set up address labels for a mass mailing.
      - **Envelopes**: Set up envelopes for a mass mailing.
      - **Catalog**: Create a single document that contains a catalog or address list.
   b) **Merge to**:
      - **New Document**: Generate merged documents, which you can edit individually in Word.
      - **Printer**: Send merged documents directly to the default printer.
      - **E-mail**: Generate merged documents designed to be e-mail messages.

6) Click **OK**. When the document opens in Word, on the **Mailings** tab, in the **Write & Insert Fields** group, click the arrow next to **Insert Merge Field**, and then click the fields that you want to add the document.

7) When you are ready to complete the merge in Word, on the **Mailings** tab in the **Finish** group, click **Finish & Merge**, and choose how to merge your document.

Create and print envelopes for a mass mailing

When you want to use envelopes to send a mass mailing to your address list, you can use mail merge to create a batch of envelopes. Each envelope contains an address from your list.

The mail merge process entails the following overall steps:

1) **Set up the envelope**: You set up the layout of the envelopes one time, for all the envelopes in the mail merge. In a mail merge, the document that you use to do this is called the main document. In the envelope main document, you can also set up any content that you want repeated on each envelope, such as a return address, a company logo, or boilerplate text.

2) **Connect the envelopes to your address list**: Your address list is the data source that Microsoft Office Word uses in the mail merge. It is a file that contains the addresses to be printed on the envelopes.

3) **Refine the list of recipients**: Word generates an envelope for each address in your mailing list. If you want to generate envelopes for only certain addresses in your mailing list, you can choose which addresses, or records, to include.
4) **Add placeholders (mail merge fields) to the envelopes:** When you perform the mail merge, the mail merge fields are filled with information from your address list.

5) **Preview and complete the mail merge:** You can preview each envelope before you print or send the whole set.

You use commands on the **Mailings** tab to perform a mail merge.

### Set up the envelope

If you want to include a return address on the envelopes, you can set this up before you start working on the envelope main document. It is also a good idea to try printing a few test envelopes to verify that your printing options are configured correctly for your printer.

#### Set up a return address

1) Start Word.

2) Click the **File** tab, and then click **Options**.

3) Click **Advanced**.

4) Scroll down, and under **General**, type your return address in the **Mailing address** box.

5) Word stores the address so that you can use it whenever you want to insert your return address in a document.

6) Click **OK**.

#### Verify the printing options

Before you run a batch of envelopes the wrong way through your printer, you can verify that the printer options are set up correctly.

1) On the **Mailings** tab, in the **Create** group, click **Envelopes**.

2) Click **Options**, and then click the **Envelope Options** tab.

   a) In the **Envelope size** box, click the choice that matches the size of your envelopes.

   - If none of the choices matches your envelope size, scroll to the bottom of the list, click **Custom size**, and then type the dimensions of your envelope in the **Width** and **Height** boxes.

3) Click the **Printing Options** tab.

   a) The printer driver sends the information to Word about which way the envelope should be loaded into the printer. This information is displayed on the **Printing Options** tab of the **Envelope Options** dialog box.

---

1) The feed method determines the position of the envelope (right, middle, left) and whether the long or short edge is being fed into the printer.

2) The envelope can be face up or face down. The face is the side that the address is printed on.

3) If the envelope is fed short edge first, the envelope may need to be rotated to prevent the text from appearing upside down on the face of the envelope.
The envelope in the illustration is positioned to the right, face down, flap at the top, and the short edge is being fed into the printer, in accordance with the settings in the dialog box shown above.

b) Load the envelope as indicated in the dialog box.
c) Click OK.

4) Type some test text in the Delivery address box, and then click Print to print the envelope.
   a) Verify that the envelope was printed correctly.
   b) If the envelope was not printed correctly, do any of the following:
      • Consult your printer information, if available, to find out how to load envelopes into the printer.
      • Update your printer driver.
      • Go back to the Printing Options tab in the Envelope Options dialog box, and make adjustments to the printing options. Print the envelope again. Repeat this process until you discover a configuration of printing options that yields the results that you want.

5) When you print the test envelope correctly, note the settings on the Printing Options tab in the Envelope Options dialog box so that you can replicate them later, during the mail merge.

Work on the envelope main document
1) Start Word.
2) A blank document opens by default. Leave it open. If you close it, the commands in the next step are not available.
3) On the Mailings tab, in the Start Mail Merge group, click Start Mail Merge.
4) Click Envelopes.
   a) In the Envelope Options dialog box, click the Envelopes Options tab, and then in the Envelope size box, click the choice that matches the size of your envelopes.
      • If none of the choices matches your envelope size, scroll to the bottom of the list, click Custom size, and then type the dimensions of your envelope in the Width and Height boxes.
   b) Make any formatting adjustments that you want in the Delivery address and Return address sections. You can see the result of your layout settings in the Preview section of the dialog box.
   c) If your verification of the printing settings reveals that you need to make adjustments to the settings, click the Printing Options tab, and make the necessary adjustments.
   d) When you finish, click OK.
5) Word creates a document where the page is sized to the specified envelope dimensions. If you have a return address set up in Word, the return address is displayed in a frame on the page. Another blank frame will contain the delivery address. To see the frame boundary, click in the body of the envelope where you expect the delivery address to appear.
Connect the envelopes to your address list
To merge information into your envelopes, you must connect the envelopes to your address list, also known as a data source or a data file. If you don’t already have a data file, you can create one during the mail merge process.

Choose a data file
1) On the Mailings tab, in the Start Mail Merge group, click Select Recipients.
2) Choose the source type from the drop down list and select the source, as necessary.

Refine the list of recipients
When you connect to a certain data file, you might not want to merge information from all the records in that data file into your envelopes.

To narrow the list of recipients or use a subset of the items in your data file, do the following:
1) On the Mailings tab, in the Start Mail Merge group, click Edit Recipient List.
2) In the Mail Merge Recipients dialog box, do any of the following:
   a) Select individual records
   b) Sort records
   c) Filter records

Add placeholders (mail merge fields)
After you connect your envelopes to your address list, you are ready to add placeholders that indicate where the addresses will appear on each envelope. You can also add the content that you want repeated on each label, such as a picture or your return address.

By putting a field in the initial envelope that you set up (envelope main document), you indicate that you want a certain category of information, such as name or address, to appear in that location.

You can add the boilerplate text and pictures to the initial envelope that you set up (your envelope main document). These elements appear the same on all of the envelopes in the merge. For example, you can include your company logo or your return address, if you haven’t already configured a reusable return address in Word.

Add the content
1) Position the cursor where you want to insert the content.
2) To add a return address if you haven’t already configured one in Word, click in the return address area on the envelope. A frame boundary appears. Type your return address in the frame.
3) To add a picture, click in either the return address or the delivery address area on the envelope, or double-click outside of the address areas. Then, on the Insert tab, in the Illustrations group, click Picture. Locate the picture and double-click it.
   a) If you need to resize the picture, select it and then hold down SHIFT while you drag the corner sizing handle. Dragging the corner sizing handle maintains the height-to-width ratio. To position the picture, right-click it, point to Text Wrapping on the shortcut menu, and then click any of the wrapping choices except In Line With Text.
Add the fields
1) In the initial envelope that you set up, click in the delivery address area.
   a) A frame border appears.
2) In the Write & Insert Fields group on the Mailings tab, add any of the following:
   a) Address Block with name, address, and other information
   b) Individual fields
   c) Custom fields from Office Outlook contacts

Preview the merge
After you add the fields to the initial envelope that you set up, you are ready to preview the mail merge results. When you are satisfied with the preview, you can complete the mail merge.

To preview, do any of the following in the Preview Results group of the Mailings tab:
1) Click Preview Results.
2) Page through each envelope by clicking the Next Record and Previous Record buttons in the Preview Results group.
3) Preview a specific document by clicking Find Recipient.

Note: Click Edit Recipient List in the Start Mail Merge group on the Mailings tab to open the Mail Merge Recipients dialog box, where you can filter the list or clear recipients if you see records that you don’t want to include.

Print the envelopes
You can print the envelopes or modify them individually. You can print or change all or just a subset of the envelopes.

1) On the Mailings tab, in the Finish group, click Finish & Merge, and then click Print Documents.
2) Choose whether to print the whole set of envelopes, only the envelope that is currently visible, or a subset of the set, which you specify by record number.

Change individual envelopes
1) On the Mailings tab, in the Finish group, click Finish & Merge, and then click Edit Individual Documents.
2) Choose whether you want to edit the whole set of envelopes, only the envelope that is currently visible, or a subset of the set, which you specify by record number. Word saves the copies that you want to edit to a single file, with a page break between each envelope.

Save the envelope main document
Remember that the envelopes you save are separate from the initial envelope that you set up (the envelope main document). It is a good idea to save the envelope main document itself if you plan to use it for another mail merge.

When you save the envelope main document, you also save its connection to the data file. The next time that you open the envelope main document, you are prompted to choose whether you want the information from the data file to be merged again into the envelope main document.
Create and print labels for a mass mailing

When you want to use address labels to send a mass mailing to your address list, you can use mail merge to create a sheet of address labels. Each label contains an address from your list.

Set up the labels

Chances are that you already have a package of label sheets from one of the label sheet suppliers, such as Avery, AOOne, or Formtec. Each sheet is a certain size and contains a certain number of labels with specific dimensions.

To set up the label main document, you need to match the dimensions of that document with the dimensions of the labels on the sheets that you have on hand.

1) Start Word.
2) A blank document opens by default. Leave it open. If you close it, the commands in the next step are not available.
3) On the Mailings tab, in the Start Mail Merge group, click Start Mail Merge.
4) Click Labels.
5) In the Label Options dialog box, you have several choices to make.

- The type of printer that you are using to print labels
- The supplier that produced your label sheets
- The number that corresponds to the product number listed on your package of label sheets

a) If the product number for your label sheets doesn't match any of the choices in the Label Options dialog box you can still print your labels. You just have to do some customizing.
   - Measure the labels on the sheet you have, and note the measurements and how many labels fit on a single sheet.
     1) Measure the labels carefully. The actual label size might be smaller than the size that is indicated by the label manufacturer. For example, a 1-by-2-inch label might actually be 15/16-inch high and 1 15/16-inches wide.
   - In the Product number list, select a label type that is similar in size to your labels.
     1) If you don't see the label type that you want in the Product number box, you may be able to use another of the listed labels, or you can create a new label size.
   - Click Details, and then compare the label dimensions and the number of labels per sheet (for labels printed on laser and ink-jet printers) or the number of columns on the label form (for labels printed on dot-matrix printers).
Do one of the following:
(1) If the dimensions and label layout match those of your labels, use the selected label.
(2) If the dimensions and layout do not match yours, click Cancel, and create a New Label.
   (a) In the Label Options dialog box, click the printer type (either Continuous-feed printers or Page printers), and then click New Label.
   (b) Type a name in the Label name box, select the height, width, margins, and other options for your label, and then click OK.
      (i) The new label appears in the Product number box as Label name - Custom. The label is also placed in the Other/Custom category. The next time you use your custom labels, be sure to select Other/Custom in the Label vendors list.

b) After you select the label options that you want, click OK.

6) Word creates a document that contains the sheet of labels. Word uses a table to lay out the labels. If you don't see lines separating the labels, click the Layout tab under Table Tools, and then in the Table group, click View Gridlines.

Connect the labels to your address list
To merge information into your labels, you must connect the labels to your address list, also known as a data source or a data file. If you don't already have a data file, you can create one during the mail merge process.

Choose a data file
1) On the Mailings tab, in the Start Mail Merge group, click Select Recipients.
2) Select your source.

Refine the list of recipients
When you connect to a certain data file, you might not want to merge information from all the records (rows) in that data file into your labels.
To narrow the list of recipients or use a subset of the items in your data file, do the following:
1) On the Mailings tab, in the Start Mail Merge group, click Edit Recipient List.
2) In the Mail Merge Recipients dialog box, do any of the following:
   a) Select individual records
   b) Sort records
   c) Filter records

Add placeholders (mail merge fields)
After you connect your labels to your address list, you are ready to add placeholders that indicate where the addresses will appear on each label. You can also type text that you want repeated on each label, such as a company logo or your return address on a shipping label.

Map the mail merge fields to your data file
To make sure that Word can find a column in your data file that corresponds to every address element, you may need to map the mail merge fields in Word to the columns in your data file.
1) To map the fields, click Match Fields in the Write & Insert Fields group on the Mailings tab.
   a) The Match Fields dialog box opens.
   b) The elements of an address are listed on the left. Column headings from your data file are listed on the right.
   c) Word searches for the column that matches each element
d) In the list on the right, you can select the column from your data file that matches the element on the left. Your mail merge label doesn't need to use every field. If you add a field that does not contain data from your data file, it will appear in the merged document as an empty placeholder — usually a blank line or a hidden field.

**Type the content and add the fields**

1) In the initial label that you set up (your label main document), click where you want to insert the field.
2) In the **Write & Insert Fields** group on the **Mailings** tab, add any of the following:
   a) Address Block with name, address, and other information
   b) Individual fields
   c) Custom fields from Office Outlook contacts

**Note:**
- If you want all of the labels of have the same setup, after adding the merge fields, click the **Update Labels** button in the **Write & Insert Fields** group of the **Mailings** tab.
- If you are using the **Step by Step Mail Merge Wizard**, click the **Update all labels** option within the task pane.

<table>
<thead>
<tr>
<th><img src="image.png" alt="Image" /></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Image" /></td>
</tr>
</tbody>
</table>

o Your document changes to show <<Address Block>> added to the rest of your labels.

**Add a graphic to labels**

If you want to add a graphic to labels that you are printing on a page printer (rather than a continuous-feed printer), you must add it to each label:

1) Position the cursor where you want to place the graphic.
2) On the **Insert** tab, in the **Illustrations** group, click **Picture** or **Clip Art**.
3) Locate the graphic and then double-click it.
   a) If you need to resize the graphic, select it and then drag a **corner** sizing handle to the size that you want. Dragging a corner handle maintains the height-to-width ratio.
   b) If the graphic does not align with the label text, right-click the graphic and do the following:
      - Point to **Text Wrapping**, and then click **More Layout Options**.
      - Click the **Text Wrapping** tab, and under **Wrapping style**, click **Square**.
      - Click the **Picture Position** tab, and under **Horizontal**, click **Alignment**, and then click the alignment that you want: **Left**, **Centered**, or **Right**.
      - Click **OK**.

**Tip:** If you want to use the same picture for each label, you can adjust the size and placement in the first label, and then copy the picture and paste it into your other labels.
**Preview the merge**
You can preview your labels and make changes before you actually complete the mail merge.

To preview, do any of the following in the **Preview Results** group of the **Mailings** tab:

1) Click **Preview Results**.
2) Page through each label by clicking the **Next Record** and **Previous Record** buttons in the **Preview Results** group on the **Mailings** tab.
3) Preview a specific document by clicking **Find Recipient**.

**Complete the merge**
You can print the labels or modify them individually. You can print or change all or just a subset of the labels.

**Print the labels**
1) On the **Mailings** tab, in the **Finish** group, click **Finish & Merge**, and then click **Print Documents**.
2) Choose whether to print the whole set of labels, only the label that is currently visible, or a subset of the set, which you specify by record number.

**Change individual labels**
1) On the **Mailings** tab, in the **Finish** group, click **Finish & Merge**, and then click **Edit Individual Documents**.
2) Choose whether you want to edit the whole set of labels, only the label that is currently visible, or a subset of the set, which you specify by record number. Word saves the labels that you want to edit to a single file.

**Save the label main document**
Remember, the merged labels that you save are separate from the initial label that you set up (the label main document). It is a good idea to save the label main document itself if you plan to use it for another mail merge.

When you save the label main document, you also save its connection to the data file. The next time that you open the label main document, you are prompted to choose whether you want the information from the data file to be merged again into the label main document.

**Create and print a sheet of the same labels**
This information applies to creating a sheet of labels that are identical.

1) Start Word.
2) A blank document opens by default. Leave it open. If you close it, the commands in the next step are not available.
3) On the **Mailings** tab, in the **Create** group, click **Labels**.
4) Leave the **Address** box blank.
5) To select the label type and other options, click **Options**.
   a) In the **Label Options** dialog box, make your choices, and then click **OK**.
   b) Under **Print**, click **Full page of the same label**.
   c) Click **New Document**.
      • Word creates a document that contains the sheet of labels. Word uses a table to lay out the labels. If you don't see lines separating the labels, click the **Layout** tab under **Table Tools**, and then in the **Table** group, click **View Gridlines**.
6) Type the text that you want in each label, and make any changes that you want to the formatting and color scheme, by using the options on the **Home** and **Page Layout** tabs. When you are finished, save or print the labels the same way that you save or print any document in Word.

**Use mail merge to send personalized e-mail messages to your e-mail address list**

When you want to send personalized e-mail to recipients in your address list, you can use mail merge to create the e-mail messages. Each message has the same kind of information, yet the content of each message is unique. For example, in e-mail to your customers, each message can be personalized to address each customer by name. The unique information in each message comes from entries in a data file. Furthermore, with mail merge, each e-mail message is a separate mailing where each recipient is the sole recipient of each message. This is unlike broadcasting an e-mail message to group of recipients or hiding recipients on the blind carbon copy (bcc) line of the message.

**Notes:**
- You must have a MAPI-compatible e-mail program installed. The capabilities of Outlook MAPI (Messaging Application Program Interface) make it possible for Microsoft Office Word and Microsoft Office Outlook to share information when sending the merged e-mail.
- You must use the same versions of Outlook and Word. If you are using Microsoft Office Word 2010, you must also use Microsoft Office Outlook 2010.
- You cannot add recipients to the Cc (Carbon copy) line. Mail merge provides no way of designating ancillary recipients. Each recipient receives a copy of the message by being addressed on the **To** line of the message.

**Set up the e-mail message main document**

1) Start Word.
   a) A blank document opens by default. Leave it open. If you close it, the commands in the next step are not available.

2) On the **Mailings** tab, in the **Start Mail Merge** group, click **Start Mail Merge**.

3) Click **E-Mail Messages**.

**Connect the e-mail message document to your address list**
To merge information into your e-mail message main document, you must connect the document to your address list, also known as a data source, or data file. If you don't already have a data file, you can create one during the mail merge process.

**Note:** Make sure that your data file includes a column for the e-mail address. You will need that column later in the process.

**Choose a data file**

1) On the **Mailings** tab, in the **Start Mail Merge** group, click **Select Recipients**.

2) Select your source type, or type a new list.

**Refine the list of recipients or items**
When you connect to a certain data file, you might not want to merge information from all the records in that data file into your e-mail message main document. If your data file includes records with no e-mail addresses, omit them from the e-mail merge. Otherwise, Word won't be able to complete the merge process.
To narrow the list of recipients or use a subset of the items in your data file, do the following:

1) On the **Mailings** tab, in the **Start Mail Merge** group, click **Edit Recipient List**.

2) In the Mail Merge Recipients dialog box, do any of the following:
   a) Select individual records.
   b) Sort records.
   c) Filter records.

**Add placeholders (mail merge fields)**
After you connect your e-mail message main document to your address list, you are ready to type the text of the message and add placeholders that indicate where the unique information will appear in each message.

**Type content and add fields**
1) In the e-mail message main document, click where you want to insert the field.

2) Use the **Write & Insert Fields** group on the **Mailings** tab, and add any of the following:
   a) Greeting line
   b) Individual fields
   c) Custom fields from Outlook contacts

**Preview and complete the merge**
After you add fields to your e-mail message main document, you are ready to preview the merge results. When you are satisfied with the preview, you can complete the merge.

To preview, do any of the following in the **Preview Results** group of the **Mailings** tab:

1) Click **Preview Results**.
   a) Page through each e-mail message by using the **Next Record** and **Previous Record** buttons in the **Preview Results** group.
   b) Preview a specific document by clicking **Find Recipient**.

**Note:** Click **Edit Recipient List** in the **Start Mail Merge** group on the **Mailings** tab to open the **Mail Merge Recipients** dialog box, where you can filter the list or clear recipients if you see records that you don't want to include.

**Save the e-mail message main document**
If you think you will want to reuse the e-mail message main document, you can save it before sending the final e-mail messages.

Remember, e-mail messages that you send are separate from the e-mail message main document. It's a good idea to save the e-mail message main document itself if you plan to use it for another mail merge.

When you save the e-mail message main document, you also save its connection to the data file. The next time you open the e-mail message main document, you're prompted to choose whether you want the information from the data file to be merged again into the e-mail message main document.
Send the e-mail messages

1) On the Mailings tab, click Finish & Merge, and then click Send E-mail Messages.
2) In the To box, select the name of the field that stores recipients' e-mail address.
3) In the Subject line box, type a subject line for the message.
4) In the Mail format box, click HTML or Plain text to send the document as the body of the e-mail message, or click Attachment to send the document as an attachment.
   Note: If you send the document as a plain text e-mail message, the e-mail message will not include any text formatting or graphics.
5) Choose whether to send the whole set of messages, only the message that's currently visible, or a subset of the set, which you specify by record number.
6) Click OK.